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1 INTRODUCTION

1.1 Caution
The GPS system is operated by the government of the United States, which is solely responsible for its accuracy and
maintenance. Although the GPS 16/17 is a precision electronic NAVigation AID (NAVAID), any NAVAID can be
misused or misinterpreted, and therefore become unsafe. Use these products at your own risk. To reduce the risk,
carefully review and understand all aspects of these Technical Specifications before using the GPS 16/17. When in
actual use, carefully compare indications from the GPS to all available navigation sources including the information
from other NAVAIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before continuing
navigation.

1.2 FCC Compliance
The GPS 16/17 complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME OR
OFFICE USE. These limits are designed to provide reasonable protection against harmful interference in a
residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
The GPS 16/17 does not contain any user-serviceable parts. Unauthorized repairs or modifications could result in
permanent damage to the equipment, and void your warranty and your authority to operate this device under Part 15
regulations.
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1.3 Limited Warranty
This Garmin product is warranted to be free from defects in materials or workmanship for one year from the date of
purchase. Within this period, Garmin will at its sole option repair or replace any components that fail in normal use.
Such repairs or replacement will be made at no charge to the customer for parts or labor, provided that the customer
shall be responsible for any transportation cost. This warranty does not cover failures due to abuse, misuse, accident,
or unauthorized alteration or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL
OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY ARISING
UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE,
STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY
VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY TO
USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not allow the exclusion of
incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the purchase price
at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY
BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer or call Garmin Product Support at one of
the numbers listed below for shipping instructions and an RMA tracking number. The unit should be securely
packed with the tracking number clearly written on the outside of the package. The unit should then be sent, freight
charges prepaid, to any Garmin warranty service station. A copy of the original sales receipt is required as the proof
of purchase for warranty repairs.

Garmin International, Inc.
1200 E 151st Street, Olathe, Kansas 66062 U.S.A.
Tel. 913/397.8200 or 800/800.1020
Fax. 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate, Romsey, SO51 9DL U.K.
Tel. 44/0870.8501241
Fax 44/0870.8501251 

Online Auction Purchases: Products sold through online auctions are not eligible for rebates or other special offers
from Garmin. Online auction confirmations are not accepted for warranty verification. To obtain warranty service,
an original or copy of the sales receipt from the original retailer is required. Garmin will not replace missing
components from any package purchased through an online auction.

International Purchases: A separate warranty is provided by international distributors for units purchased outside
the United States. This warranty is provided by the local in-country distributor and this distributor provides local
service for your unit. Distributor warranties are only valid in the area of intended distribution. Units purchased in the
United States or Canada must be returned to the Garmin service center in the United Kingdom, the United States,
Canada, or Taiwan for service. 
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1.4 Overview
The GPS 16/17 series products are complete GPS sensors including embedded receiver and antenna, designed for a
broad spectrum of OEM (Original Equipment Manufacture) system applications. Based on the proven technology
found in other Garmin 12-channel GPS receivers, the GPS 16/17 tracks up to 12 satellites at a time while providing
fast time-to-first-fix, one-second navigation updates, and low power consumption. This generation of GPS sensors
adds the capability of FAA Wide Area Augmentation System (WAAS) differential GPS. The GPS 16/17’s far-
reaching capability meets the sensitivity requirements of land navigation as well as the dynamics requirements of
high-performance aircraft.

The GPS 16/17 design uses the latest technology and high-level circuit integration to achieve superior performance
while minimizing space and power requirements. All critical components of the system including the RF/IF receiver
hardware and the digital baseband are designed and manufactured by Garmin to ensure the quality and capability of
the GPS. The hardware capability combined with software intelligence makes the GPS 16/17 easy to integrate and
use.

The GPS 16/17 series products are designed to withstand rugged operating conditions and are waterproof to IEC
60529 IPX7, immersion in 1 meter of water for 30 minutes. These complete GPS receivers require minimal
additional components to be supplied by an OEM or system integrator. A minimum system must provide the GPS
with a source of power and a clear view of the GPS satellites. The system may communicate with the GPS via two
full-duplex communication channels. Internal FLASH memory allows the GPS to retain critical data such as satellite
orbital parameters, last-known position, date, and time. End user interfaces such as keyboards and displays are the
responsibility of the application designer.

1.5 Features
• 12-channel GPS receiver tracks and uses up to 12 satellites for fast, accurate positioning and low power

consumption.
• Differential DGPS capability using real-time WAAS or RTCM corrections yielding 3 to 5 meter position

accuracy (see Section 1.7 Technical Specifications).
• Compact, rugged design ideal for applications with minimal space. 
• May be remotely mounted in an out-of-the-way location. 
• Receiver position information can be displayed directly on a chartplotter or PC.
• User initialization is not required. Once the unit is installed and has established a location fix, the unit

automatically produces navigation data.
• User-configurable navigation mode (2-dimensional or 3-dimensional fix).
• Highly accurate one-pulse-per-second (PPS) output for precise timing measurements. Pulse width is

configurable in 20 millisecond increments from 20 ms to 980 ms with 1 µs accuracy.
• Configurable for binary format carrier phase data output on COM 1 port.
• Flexible input voltage levels of 3.3 VDC to 6.0 VDC with over-voltage protection in the GPS 16LVS, and

8.0 VDC to 40 VDC in the GPS 16HVS and GPS 17HVS.
• FLASH-based program and non-volatile memory. New software revisions available through Web site

download. Non-volatile memory does not require battery backup.
• Waterproof design allows continuous exposure to the prevailing weather conditions at most locations.
• GPS 17HVS can be flush mounted or pole mounted on the enclosed 1” marine mast mount. 

http://www.garmin.com/aboutGPS/waas.html
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1.6 GPS 16/17 Series
There are several different products in the GPS 16/17 product series, as described below. 

1.6.1 GPS 16LVS & 16HVS
Both the GPS 16LVS and GPS 16HVS are black with a white logo. 

GPS 16LVS & 16HVS

1.6.2 GPS 17HVS 
The GPS 17HVS is white with a blue logo. GPS 17HVS can be flush mounted or pole mounted on the enclosed 1”
pole mount (also called a marine mount). You can also use the GPS17HVS on a standard one-inch, 14 threads-per-
inch marine mount. 

GPS17HVS with Pole Mount

GPS 17HVS Flush Mount
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1.7 Technical Specifications
Specifications are subject to change without notice.

1.7.1 Physical Characteristics
1.7.1.1 Size
• GPS 16: 3.58” (91.0 mm) diameter, 1.65” (42 mm) high
• GPS 17: 3.58” (91.0 mm) diameter, 3.60” (91.5 mm) high

1.7.1.2 Weight
• GPS 16LVS & 16HVS only: 6.4 oz (181 g)  
• GPS 16LVS & 16HVS with 5-meter cable: 11.7 oz (332 g)
• GPS 16LVS & 16HVS cable alone: 5.3 oz (151 g)
• GPS 17HVS only: 7.1 oz (201 g)  
• GPS 17HVS with 30-foot cable: 16.8 oz (465 g)
• GPS 17HVS with pole mount adapter & cable: 18.2 oz (516 g)
• GPS 17HVS pole mount adapter alone: 1.4 oz (40 g)
• GPS 17HVS cable alone: 9.7 oz (275 g)

1.7.1.3 Cable
• GPS 16LVS & 16HVS: Black PVC-jacketed, 5-meter, foil-shielded, 8-conductor 28 AWG with RJ-45 termination
• GPS 17HVS: White PVC-jacketed, 30-foot, foil-shielded, 8-conductor 28 AWG with JST connector termination

1.7.1.4 Color
• GPS 16LVS & 16HVS: Black with white logos
• GPS 17HVS: White with blue logos

1.7.1.5 Case Material
Polycarbonate thermoplastic that is waterproof to IEC 60529 IPX7 level (immersion in 1 meter of water for 30
minutes).

1.7.1.6 GPS 17HVS Thread Specifications
Standard one-inch, 14 threads-per-inch

1.7.2 Electrical Characteristics
1.7.2.1 Input Voltage
• GPS 16LVS: 3.3 VDC to 6.0 VDC regulated, <100 mV ripple
• GPS 16HVS & 17HVS: 8.0 VDC to 40 VDC unregulated

1.7.2.2 Input Current 
• GPS 16HVS, GPS 17HVS 60 mA @ 8 VDC

40 mA @ 12 VDC
15 mA @ 40 VDC

• GPS 16LVS: 65 mA typical

1.7.2.3 Standby Current
<1mA for all GPS 16 and GPS 17 models

1.7.2.4 GPS Receiver Sensitivity
-165 dBW minimum

1.7.3 Environmental Characteristics
• Operating Temperature: -30°C to +80°C 
• Storage Temperature: -40°C to +80°C
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1.7.4 GPS Performance
1.7.4.1 Receiver 
WAAS Enabled™; 12 parallel channel GPS receiver continuously tracks and uses up to 12 satellites (up to 11 with
PPS active) to compute and update your position.

1.7.4.2 Acquisition Times
• Reacquisition: Less than 2 seconds
• Warm: Approx. 15 seconds (all data known)
• Cold: Approx. 45 seconds (initial position, time, and almanac known; ephemeris unknown)
• AutoLocate®: 5 minutes (almanac known; initial position and time unknown)
• SkySearch: 5 minutes (no data known)

1.7.4.3 Sentence Rate
1 second default; NMEA 0183 output interval configurable from 1 to 900 seconds in 1-second increments

1.7.4.4 Accuracy
• GPS Standard Positioning Service (SPS)

Position: <15 meters, 95% typical (100 meters with Selective Availability on)
Velocity: 0.1 knot RMS steady state

• DGPS (USCG/RTCM)
Position: 3–5 meters, 95% typical
Velocity: 0.1 knot RMS steady state

• DGPS (WAAS)
Position: <3 meters, 95% typical
Velocity: 0.1 knot RMS steady state

• PPS Time: ±1 microsecond at rising edge of PPS pulse (subject to Selective Availability)
• Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 6g dynamics

1.7.5 Interfaces
• True RS-232 output, asynchronous serial input compatible with RS-232 or TTL voltage levels, RS-232 polarity.
• User selectable baud rate: 300, 600, 1200, 2400, 4800, 9600, 19200, or 38400.

1.7.5.1 Port 1
• Configurable between NMEA 0183 Versions 2.00 and 3.00
• ASCII output sentences GPALM, GPGGA, GPGLL, GPGSA, GPGSV, GPRMC, GPVTG (NMEA-approved

sentences); PGRMB, PGRME, PGRMF, PGRMM, PGRMT, and PGRMV (Garmin proprietary sentences)
• NMEA 0183 Outputs (see Section 4.2 Transmitted NMEA 0183 Sentences for full protocol specifications)

Position, velocity, and time
Receiver and satellite status
Differential Reference Station ID and RTCM Data age
Geometry and error estimates

• NMEA 0183 Inputs (see Section 4.1 Received NMEA 0183 Sentences for full protocol specifications)
Initial position, date, and time (not required)
Earth datum and differential mode configuration command, PPS Enable, GPS satellite almanac

• Configurable for binary data output including GPS carrier phase data

1.7.5.2 Port 2
Real-time Differential Correction input (RTCM SC-104 message types 1, 2, 3, 7, and 9)

1.7.5.3 PPS
1 Hz pulse, programmable width, 1 µs accuracy

1.7.5.4 Power Control
• Off: Open circuit
• On: Ground, or pull to low logic level <0.3 volts

http://www.garmin.com/aboutGPS/waas.html
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2 GPS 16/17 WIRING AND PINOUTS

2.1 GPS 16/17 Pinout
The GPS 16LVS and GPS 16HVS sensors utilize an 8-pin RJ-45 plug. The GPS 17HVS terminates in a JST
connector, which is mainly for factory testing; you can remove the JST connector without voiding your warranty.
The following is a functional description of each wire in the cable assembly. 

RJ-45
Pin
#

Wire
Color Signal

Name Description

1 Red POWER GPS 16LVS: Regulated +3.3 to +6 VDC. Typical operating current is 80 mA. An
internal 6.8 V transient zener diode and a positive temperature coefficient
thermistor protect from transients and over-voltages. With voltages greater than
6.8 VDC the zener will draw several amps of current through the thermistor,
causing it to heat rapidly and eventually power the unit off, unless an external
fuse blows first. When proper supply voltages are returned, the thermistor will
cool and allow the GPS 16LVS to operate.
GPS 16HVS & GPS 17HVS: Vin can be an unregulated 8.0 VDC to 40 VDC,
optimized for 12 VDC. Typical operating power is 800 mW. This voltage drives a
switching regulator with a nominal 5.0 VDC output, which powers an internal
linear regulator, producing the system Vcc.

2 Black GROUND Power and Signal Ground
3 Yellow REMOTE

POWER
ON/OFF

External Power Control Input. Active (ON) if less than 0.3 VDC. Inactive (OFF)
if open-circuit. Pulling this pin to ground enables the unit; leaving the pin open-
circuited powers the internal regulators off and drops the supply current to less
than 1 mA. This input is intended to be driven by an open-collector output.

4 Blue PORT 1
DATA IN

First Serial Asynchronous Input. RS-232 compatible with maximum input
voltage range -25 < V < 25. This input may also be directly connected to standard
3 to 5 VDC CMOS logic. The low signal voltage requirement is <0.6 V, and the
high signal voltage requirement is >2.4 V. Input impedance is between 3.0 and
7.0 kΩ. This input may be used to receive serial initialization/ configuration data
as specified in Section 4.1 Received NMEA 0183 Sentences.

5 White PORT 1
DATA
OUT

First Serial Asynchronous Output. This RS-232 compatible output normally
provides serial data which is formatted per NMEA 0183, Version 3.0. This output
is also capable of outputting phase data information; see Appendix C for details.
The NMEA 0183 baud rate is switchable in the range of 300 to 38400 baud. The
default baud rate is 4800.

6 Gray PPS One-Pulse-Per-Second Output. Typical voltage rise and fall times are 300 ns.
Impedance is 150 Ω. Open circuit output voltage is low = 0 V and high = Vin in
the GPS 16LVS, and low = 0 V and high = 5.0 V in the GPS 16HVS and GPS
17HVS. The default format is a 100 ms wide active-high pulse at a 1 Hz rate; the
pulse width is configurable in 20 ms increments. Rising edge is synchronized to
the start of each GPS second. This output provides between 800 mVp-p to
1.7 Vp-p for GPS 16LVS and 1.4 Vp-p for the GPS 16HVS and 17HVS into a
50 Ω load. The pulse time measured at the 50% voltage point will be about 50 ns
earlier with a 50 Ω load than with no load.

7 Green PORT 2
DATA IN

Second Serial Asynchronous Input, electrically identical to PORT 1 DATA IN.
This input may be used to receive serial differential GPS data formatted per
RTCM SC-104 Recommended Standards For Differential Navstar GPS Service,
Version 2.2 (see Section 4.5 Received RTCM Data for details).

8 Violet PORT 2
DATA
OUT

Second Serial Asynchronous Output, electrically identical to PORT 1 DATA
OUT. Reserved for future use.

Table 1: GPS 16/17 Wire Pinout
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2.2 GPS 16/17 Wiring Diagrams

Figure 1: Computer Serial Port Interconnection

Figure 2: PDA Serial Port Interconnection

Figure 3: Basic NMEA Device Interconnection
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3 MECHANICAL CHARACTERISTICS & MOUNTING 

3.1 GPS 16 and GPS 17 Flush Mount

Figure 4: GPS 16 & GPS 17 Flush Mount Dimensions

1.65 inches [42 mm]

3.58 inches [91 mm]

2.44 inches [62 mm]

120 Degrees
M4 Thread
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3.2 GPS 17

Figure 5: GPS 17 Dimensions

3.60 inches (91.5 mm)

0.27 inches [7 mm]

3.58 inches [91 mm]
Fits on a standard one-
inch, 14 threads-per-inch
marine mount.

M4 Thread
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Figure 6: GPS 17 Attaching to the Included Pole Mount

3.3 GPS 16 Optional Magnetic Mount 

Figure 7: Optional GPS 16 Magnetic Mount

Magnetic Mount

M4 Flat Head Screws
(3 each)
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4 SOFTWARE INTERFACE
The GPS 16/17 series products interface protocol design on COM 1 is based on the National Marine Electronics
Association’s NMEA 0183 ASCII interface specification. The COM 2 port can receive differential GPS (DGPS)
correction data using the Radio Technical Commission for Maritime Services’ RTCM SC-104 standard. These
standards are fully defined in NMEA 0183, Version 3.0 (copies may be obtained from NMEA, www.nmea.org) and
RTCM Recommended Standards For Differential Navstar GPS Service, Version 2.2, RTCM Special Committee No.
104 (copies may be obtained from RTCM, www.rtcm.org).

The GPS 16/17 series products interface protocol, in addition to transmitting navigation information as defined by
NMEA 0183, transmits additional information using the convention of Garmin proprietary sentences.

Binary phase data information can alternatively be output on the COM 1 port; see Appendix B: Binary Phase Output
Format for details.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by the GPS
16/17 series products. The baud rate selection, one-pulse-per-second output interfaces and RTCM differential GPS
input are also described.

4.1 Received NMEA 0183 Sentences
The following paragraphs define the sentences that can be received on the GPS sensors’ COM 1 port. Null fields in
the configuration sentence indicate no change in the particular configuration parameter. All sentences received by
the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return (0D hexadecimal) and
line feed (0A hexadecimal). The checksum *hh is used for parity checking data and is not required, but is
recommended for use in environments containing high electromagnetic noise. It is generally not required in normal
PC environments. When used, the parity bytes (hh) are the ASCII representation of the exclusive-or (XOR) sum of
all the characters between the “$” and “*” characters, non-inclusive. The hex representation must be a capital letter,
such as 3D instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that
point will be acted on by the sensor.

4.1.1 Almanac Information (ALM)
The $GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the unlikely event
of non-volatile memory loss or after storing longer than six months without tracking GPS satellites.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<1> Total number of ALM sentences to be transmitted by the GPS sensor during almanac download. This
field can be null or any number when sending almanac to the GPS sensor.

<2> Number of current ALM sentence. This field can be null or any number when sending almanac to the
GPS sensor.

<3> Satellite PRN number, 01 to 32
<4> GPS week number
<5> SV health, bits 17-24 of each almanac page
<6> Eccentricity
<7> Almanac reference time
<8> Inclination angle
<9> Rate of right ascension

<10> Root of semi major axis
<11> Omega, argument of perigee
<12> Longitude of ascension node
<13> Mean anomaly
<14> af0 clock parameter
<15> af1 clock parameter

http://www.nmea.org)/
http://www.rtcm.org/
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4.1.2 Sensor Initialization Information (PGRMI)
The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used for
satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the satellite acquisition
process. If there are no errors in the sentence, it will be echoed upon receipt. If an error is detected, the echoed
PGRMI sentence will contain the current default values. Current PGRMI defaults (with the exception of the
Receiver Command, which is a command rather than a mode) can also be obtained by sending $PGRMIE to the
GPS sensor.

$PGRMI,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Latitude, ddmm.mmm format (leading zeros must be transmitted)
<2> Latitude hemisphere, N or S
<3> Longitude, dddmm.mmm format (leading zeros must be transmitted)
<4> Longitude hemisphere, E or W
<5> Current UTC date, ddmmyy format
<6> Current UTC time, hhmmss format
<7> Receiver Command, A = Auto Locate, R = Unit Reset

4.1.3 Sensor Configuration Information (PGRMC)
The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC sentence will contain
the current default values. Current default values can also be obtained by sending $PGRMCE to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<1> Fix mode, A = automatic, 2 = 2D exclusively (host system must supply altitude),
3 = 3D exclusively

<2> Altitude above/below mean sea level, -1500.0 to 18000.0 meters
<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must contain valid

values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A: Earth Datums for a list of
earth datums and the corresponding earth datum index.

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters resolution)
<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10-9 resolution)
<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)
<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)
<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)
<9> Differential mode, A = automatic (output DGPS data when available, non-DGPS otherwise), D =

differential exclusively (output only differential fixes)
<10> NMEA 0183 Baud rate, 1 = 1200, 2 = 2400, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600, 8 = 38400
<11> Velocity filter, 0 = No filter, 1 = Automatic filter, 2 to 255 = Filter time constant (e.g., 10 = 10 second

filter)
<12> PPS mode, 1 = Off, 2 = On
<13> PPS pulse length, 0 though 48 = (n+1)*20 ms.

Example: n = 4 corresponds to a 100 ms wide pulse
<14> Dead reckoning valid time 1to 30 (sec)

All configuration changes take affect after receipt of a valid value except baud rate and PPS mode. Baud rate and
PPS mode changes take effect on the next power cycle or an external reset event.
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4.1.4 Additional Sensor Configuration Information (PGRMC1)
The $PGRMC1 sentence provides additional information used to configure the GPS sensor operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this
sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC1 sentence will contain
the current default values. Current default values can also be obtained by sending $PGRMC1E to the GPS sensor.

$PGRMC1,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<1> NMEA 0183 output time 1-900 (sec) 
<2> Binary Phase Output Data, 1 = Off, 2 = On.
<3> Automatic Position Averaging when Stopped, 1 = Off, 2 = On
<4> DGPS beacon frequency: 0.0, 283.5–325.0 kHz in 0.5 kHz steps
<5> DGPS beacon bit rate: 0, 25, 50, 100, or 200 bps
<6> DGPS beacon scanning, 1 = Off, 2 = On
<7> NMEA 0183 version 2.30 mode indicator, 1 = Off, 2 = On
<8> DGPS mode, W = WAAS Only, N = None (DGPS disabled)
<9> Power Save Mode, P = Power Save mode, N = Normal

<10> No Effect (Adaptive Transmission Enabled, 1 = Off, 2 = On)
<11> No Effect (Auto Power Off, 1 = Off, 2 = On)
<12> No Effect (Power On with External Charger, 1 = Off, 2 = On)
<13> PPS Auto Off Mode, 1 = Off, 2 = On
<14> Velocity Filter, 1 = Off, 2 = On (default value). When Off, the speed and North and East velocities are not

filtered (or masked to 0.0) at low speeds. 
Configuration changes take effect immediately, with the exception of Binary Phase Output Data and PPS Auto Off
Mode, which take effect on the next power cycle or a reset event. A reset can be commanded by sending the
sentence “$PGRMI,,,,,,,R” (see Section 4.1.2 Sensor Initialization Information (PGRMI)). If the GPS sensor is in the
Binary data mode, it is necessary to send the following eight-byte data stream to temporarily change the data format
to NMEA 0183. Then follow by sending a PGRMC1 sentence that turns off the Binary Phase Output Data format:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

4.1.5 Output Sentence Enable/Disable (PGRMO)
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following sentences
are enabled at the factory: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT. This sentence is not intended for
turning on and off sentences as a means of polling while the receiver is in use; instead, it is intended to allow
systems integrators to initialize the GPS receiver so it produces only the sentences required by the target application.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> Target sentence description (e.g., PGRMT, GPGSV, etc.)
<2> Target sentence mode, where:

0 = disable specified sentence
1 = enable specified sentence
2 = disable all output sentences 
3 = enable all output sentences (except GPALM)
4 = restore factory default output sentences

The following notes apply to the PGRMO input sentence:

1. If the target sentence mode is ‘2’ (disable all), ‘3’ (enable all), or ‘4’ (restore defaults), the target sentence
description is not checked for validity. In this case, an empty field is allowed (e.g., $PGRMO,,3), or the mode
field may contain from 1 to 5 characters.

2. If the target sentence mode is ‘0’ (disable) or ‘1’ (enable), the target sentence description field must be an
identifier for one of the sentences that can be output by the GPS sensor.

3. If either the target sentence mode field or the target sentence description field is not valid, the PGRMO sentence
will have no effect.

4. $PGRMO,GPALM,1 will cause the GPS sensor to transmit all stored almanac information. All other NMEA
0183 sentence transmission will be suspended temporarily.

5. $PGRMO,,G will cause the COM port to change to Garmin Data Transfer format for the duration of the power
cycle. You must enable Garmin Data Transfer format to update the GPS 16/17 series products.
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4.1.6 Tune DGPS Beacon Receiver (PSLIB)
The $PSLIB sentence provides the ability to tune a Garmin GBR 21, GBR 23 or equivalent beacon receiver.

$PSLIB,<1>,<2>*hh<CR><LF>

<1> Beacon tune frequency, 0.0, 283.5–325.0 kHz in 0.5 kHz steps
<2> Beacon bit rate, 0, 25, 50, 100, or 200 bps

If valid data is received, the GPS sensor will store it in the EEPROM and echo the PSLIB command to the beacon
receiver. If the GPS sensor is using any stored beacon frequency other than 0.0, it will tune the beacon receiver once
immediately after power up or external reset.

4.2 Transmitted NMEA 0183 Sentences
The subsequent paragraphs define the sentences that can be transmitted on COM 1 by the GPS sensor.

4.2.1 Sentence Transmission Rate
Sentences are transmitted with respect to the user selected baud rate.

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence descriptions) at a
periodic rate based on the user selected baud rate and user selected output sentences. The GPS sensor will transmit
the selected sentences contiguously. The length of the transmission can be determined by the following equation and
Tables 2 and 3:

total characters to be transmitted
length of transmission = ---------------------------------------------

characters transmitted per second

Sentence Output by Default? Maximum Characters
GPRMC 74
GPGGA 82
GPGSA 66
GPGSV 70
PGRME 35
GPGLL 44
GPVTG 42
PGRMV 32
PGRMF 82
PGRMB 40
PGRMM 32
PGRMT Once per minute 50

Table 2: NMEA 0183 Output Sentence Order and Size

Baud Characters per Second
300 30
600 60

1200 120
2400 240
4800 480
9600 960

19200 1920
38400 3840

Table 3: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values in the
table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The factory set
defaults will result in a once-per-second transmission at the NMEA 0183 specification transmission rate of 4800
baud.

Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the one-pulse-
per-second output pulse immediately preceding the GPRMC sentence, or whichever sentence is output first in the
burst (see Table 2 above). 
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4.2.2 Transmitted Time
The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted sentences.
Before the initial position fix, the on-board clock provides the date and time of day. After the initial position fix, the
date and time of day are calculated using GPS satellite information and are synchronized with the one-pulse-per-
second output.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and correct the
transmitted date and time of day. The transmitted date and time of day for leap second correction follow the
guidelines in National Institute of Standards and Technology Special Publication 432 (Revised 1990). This
document is for sale by the Superintendent of Documents, U.S. Government Printing Office, Washington, D.C.,
20402, U.S.A.

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s) of the
day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The GPS sensor
would have transmitted this information for the leap second added December 31, 1998 as follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second will be deleted at the end of some UTC month. The minute
containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not transmit the time of
day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69

$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A

$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Almanac Data (ALM)
Almanac sentences are not normally transmitted. Almanac transmission can be initiated by sending the GPS sensor a
$PGRMO,GPALM,1 command. Upon receipt of this command, the GPS sensor will transmit available almanac
information on GPALM sentences. During the transmission of almanac sentences, other NMEA 0183 data output
will be suspended temporarily.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<field information> can be found in Section 4.1.1 Almanac Information (ALM).

4.2.4 Global Positioning System Fix Data (GGA)
$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,M,<10>,M,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Latitude, ddmm.mmmm format (leading zeros will be transmitted) 
<3> Latitude hemisphere, N or S
<4> Longitude, dddmm.mmmm format (leading zeros will be transmitted) 
<5> Longitude hemisphere, E or W
<6> GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 = Differential GPS

(DGPS) fix available, 6 = Estimated
<7> Number of satellites in use, 00 to 12 (leading zeros will be transmitted)
<8> Horizontal dilution of precision, 0.5 to 99.9
<9> Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> Geoidal height, -999.9 to 9999.9 meters
<11> Differential GPS (RTCM SC-104) data age, number of seconds since last valid RTCM transmission (null if

not an RTCM DGPS fix)
<12> Differential Reference Station ID, 0000 to 1023 (leading zeros will be transmitted, null if not an RTCM

DGPS fix)
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4.2.5 GPS DOP and Active Satellites (GSA)
$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>*hh<CR><LF>

<1> Mode, M = manual, A = automatic
<2> Fix type, 1 = not available, 2 = 2D, 3 = 3D
<3> PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be transmitted)
<4> Position dilution of precision, 0.5 to 99.9
<5> Horizontal dilution of precision, 0.5 to 99.9
<6> Vertical dilution of precision, 0.5 to 99.9

4.2.6 GPS Satellites in View (GSV)
$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Total number of GSV sentences to be transmitted
<2> Number of current GSV sentence
<3> Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)
<4> Satellite PRN number, 01 to 32 (leading zeros will be transmitted)
<5> Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)
<6> Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)
<7> Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros will be transmitted)

Note: Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites per sentence.
Additional satellites in view information must be sent in subsequent bursts of NMEA 0183 data. These fields will be
null if unused.

4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC)
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Status, A = Valid position, V = NAV receiver warning
<3> Latitude, ddmm.mmmm format (leading zeros will be transmitted) 
<4> Latitude hemisphere, N or S
<5> Longitude, dddmm.mmmm format (leading zeros will be transmitted) 
<6> Longitude hemisphere, E or W
<7> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted)
<8> Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted)
<9> UTC date of position fix, ddmmyy format

<10> Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted)
<11> Magnetic variation direction, E or W (westerly variation adds to true course)
<12> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid

4.2.8 Track Made Good and Ground Speed (VTG)
$GPVTG,<1>,T,<2>,M,<3>,N,<4>,K,<5>*hh<CR><LF>

<1> True course over ground, 000 to 359 degrees (leading zeros will be transmitted)
<2> Magnetic course over ground, 000 to 359 degrees (leading zeros will be transmitted)
<3> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted)
<4> Speed over ground, 0000.0 to 1851.8 kilometers per hour (leading zeros will be transmitted)
<5> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid
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4.2.9 Geographic Position (GLL)
$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Latitude, ddmm.mmmm format (leading zeros will be transmitted) 
<2> Latitude hemisphere, N or S
<3> Longitude, dddmm.mmmm format (leading zeros will be transmitted)
<4> Longitude hemisphere, E or W
<5> UTC time of position fix, hhmmss format
<6> Status, A = Valid position, V = NAV receiver warning
<7> Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,

D = Differential, E = Estimated, N = Data not valid

4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>,M,<2>,M,<3>,M*hh<CR><LF>

<1> Estimated horizontal position error (HPE), 0.0 to 999.9 meters
<2> Estimated vertical position error (VPE), 0.0 to 999.9 meters
<3> Estimated position error (EPE), 0.0 to 999.9 meters

4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<1> GPS week number (0 to 1023)
<2> GPS seconds (0 to 604799)
<3> UTC date of position fix, ddmmyy format
<4> UTC time of position fix, hhmmss format
<5> GPS leap second count
<6> Latitude, ddmm.mmmm format (leading zeros will be transmitted)
<7> Latitude hemisphere, N or S
<8> Longitude, dddmm.mmmm format (leading zeros will be transmitted)
<9> Longitude hemisphere, E or W

<10> Mode, M = manual, A = automatic
<11> Fix type, 0 = no fix, 1 = 2D fix, 2 = 3D fix
<12> Speed over ground, 0 to 1851 kilometers/hour
<13> Course over ground, 0 to 359 degrees, true
<14> Position dilution of precision, 0 to 9 (rounded to nearest integer value)
<15> Time dilution of precision, 0 to 9 (rounded to nearest integer value)

4.2.12 Map Datum (PGRMM)
The Garmin Proprietary sentence $PGRMM gives the name of the map datum currently in use by the GPS sensor.
This information is used by the Garmin MapSource real-time plotting application.

$PGRMM,<1>*hh<CR><LF>

<1> Name of map datum currently in use (variable length field, e.g., “WGS 84”)

4.2.13 Sensor Status Information (PGRMT)
The Garmin Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor. This
sentence is transmitted once per minute regardless of the selected baud rate.

$PGRMT,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<1> Product, model and software version (variable length field, e.g., “GPS 16/17HVS VER 2.05”)
<2> ROM checksum test, P = pass, F = fail
<3> Receiver failure discrete, P = pass, F = fail
<4> Stored data lost, R = retained, L = lost
<5> Real time clock lost, R = retained, L = lost
<6> Oscillator drift discrete, P = pass, F = excessive drift detected
<7> Data collection discrete, C = collecting, null if not collecting
<8> GPS sensor temperature in degrees C
<9> GPS sensor configuration data, R = retained, L = lost
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4.2.14 3D Velocity Information (PGRMV)
$PGRMV,<1>,<2>,<3>*hh<CR><LF>

<1> True east velocity, -514.4 to 514.4 meters/second 
<2> True north velocity, -514.4 to 514.4 meters/second
<3> Up velocity, -999.9 to 999.9 meters/second

4.2.15 DGPS Beacon Information (PGRMB)
Note: PGRMB is not supported at this time. 

$PGRMB,<1>,<2>,<3>,<4>,<5>,K,<6>,<7>*hh<CR><LF>

<1> Beacon tune frequency, 0.0, 283.5–325.0 kHz in 0.5 kHz steps
<2> Beacon bit rate, 0, 25, 50, 100, or 200 bps
<3> Beacon SNR, 0 to 31
<4> Beacon data quality, 0 to 100
<5> Distance to beacon reference station in kilometers
<6> Beacon receiver communication status (0 = Check Wiring, 1 = No Signal, 2 = Tuning, 3 = Receiving, 4=

Scanning)
<7> DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix)
<8> DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS disabled)

4.3 Baud Rate Selection
Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor as
described in the $PGRMC Section 4.1.3 Sensor Configuration Information (PGRMC), field <10>.

4.4 One-Pulse-Per-Second (PPS) Output
The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise timing
measurements. The signal is generated after the initial position fix has been calculated and continues until power
down. The rising edge of the signal is synchronized to the start of each GPS second. Regardless of the selected baud
rate, the information transmitted by the GPS sensor is referenced to the pulse immediately preceding the NMEA
0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS sensor can compute a valid
position fix. To obtain the most accurate results, the one-pulse-per-second output should be calibrated against a local
time reference to compensate for cable and internal receiver delays and the local time bias. 

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 980 ms
as described in $PGRMC Section 4.1.3 Sensor Configuration Information (PGRMC), field <13>.

4.5 Received RTCM Data
Position accuracy of less than 5 meters can be achieved with the GPS 16/17 series products by using Differential
GPS (DGPS) real-time pseudo-range correction data in RTCM SC-104 format, with message types 1, 2, 3, 7, and 9.
These corrections can be received by the GPS 16/17 series products on COM 2. The RTCM data must be received at
the same baud rate as the COM 1 port. For details on the SC-104 format, refer to RTCM Paper 134-89/SC 104-68 by
the Radio Technical Commission for Maritime Services.
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APPENDIX A: EARTH DATUMS
The following is a list of the Garmin GPS 16/17 Earth datum indices and the corresponding earth datum name
(including the area of application):

0 ADINDAN - Ethiopia, Mali, Senegal, Sudan

1 AFGOOYE - Somalia

2 AIN EL ABD 1970 - Bahrain Island, Saudi Arabia

3 ANNA 1 ASTRO 1965 - Cocos Island

4 ARC 1950 - Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe

5 ARC 1960 - Kenya, Tanzania

6 ASCENSION ISLAND 1958 - Ascension Island

7 ASTRO BEACON “E” - Iwo Jima Island

8 AUSTRALIAN GEODETIC 1966 - Australia, Tasmania Island

9 AUSTRALIAN GEODETIC 1984 - Australia, Tasmania Island

10 ASTRO DOS 71/4 - St. Helena Island

11 ASTRONOMIC STATION 1952 - Marcus Island

12 ASTRO B4 SOROL ATOLL - Tern Island

13 BELLEVUE (IGN) - Efate and Erromango Islands

14 BERMUDA 1957 - Bermuda Islands

15 BOGOTA OBSERVATORY - Colombia

16 CAMPO INCHAUSPE - Argentina

17 CANTON ASTRO 1966 - Phoenix Islands

18 CAPE CANAVERAL - Florida, Bahama Islands

19 CAPE - South Africa

20 CARTHAGE - Tunisia

21 CHATHAM 1971 - Chatham Island (New Zealand)

22 CHUA ASTRO - Paraguay

23 CORREGO ALEGRE - Brazil

24 DJAKARTA (BATAVIA) - Sumatra Island (Indonesia)

25 DOS 1968 - Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967 - Easter Island

27 EUROPEAN 1950 - Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy,
Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979 - Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910 - Finland

30 GANDAJIKA BASE - Republic of Maldives

31 GEODETIC DATUM 1949 - New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936 - England, Isle of Man, Scotland, Shetland Islands,
Wales

33 GUAM 1963 - Guam Island

34 GUX 1 ASTRO - Guadalcanal Island

35 HJORSEY 1955 - Iceland
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36 HONG KONG 1963 - Hong Kong

37 INDIAN - Bangladesh, India, Nepal

38 INDIAN - Thailand, Vietnam

39 IRELAND 1965 - Ireland

40 ISTS O73 ASTRO 1969 - Diego Garcia

41 JOHNSTON ISLAND 1961 - Johnston Island

42 KANDAWALA - Sri Lanka

43 KERGUELEN ISLAND - Kerguelen Island

44 KERTAU 1948 - West Malaysia, Singapore

45 L.C. 5 ASTRO - Cayman Brac Island

46 LIBERIA 1964 - Liberia

47 LUZON - Mindanao Island

48 LUZON - Phillippines (excluding Mindanao Island)

49 MAHE 1971 - Mahe Island

50 MARCO ASTRO - Salvage Islands

51 MASSAWA - Eritrea (Ethiopia)

52 MERCHICH - Morocco

53 MIDWAY ASTRO 1961 - Midway Island

54 MINNA - Nigeria

55 NORTH AMERICAN 1927 - Alaska

56 NORTH AMERICAN 1927 - Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927 - Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras,
Nicaragua)

58 NORTH AMERICAN 1927 - Canal Zone

59 NORTH AMERICAN 1927 - Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927 - Caribbean (Barbados, Caicos Islands, Cuba, Dominican Republic, Grand
Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927 - Mean Value (CONUS)

62 NORTH AMERICAN 1927 - Cuba

63 NORTH AMERICAN 1927 - Greenland (Hayes Peninsula)

64 NORTH AMERICAN 1927 - Mexico

65 NORTH AMERICAN 1927 - San Salvador Island

66 NORTH AMERICAN 1983 - Alaska, Canada, Central America, CONUS, Mexico

67 NAPARIMA, BWI - Trinidad and Tobago

68 NAHRWAN - Masirah Island (Oman)

69 NAHRWAN - Saudi Arabia

70 NAHRWAN - United Arab Emirates

71 OBSERVATORIO 1966 - Corvo and Flores Islands (Azores)

72 OLD EGYPTIAN - Egypt

73 OLD HAWAIIAN - Mean Value

74 OMAN - Oman
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75 PICO DE LAS NIEVES - Canary Islands

76 PITCAIRN ASTRO 1967 - Pitcairn Island

77 PUERTO RICO - Puerto Rico, Virgin Islands

78 QATAR NATIONAL - Qatar

79 QORNOQ - South Greenland

80 REUNION - Mascarene Island

81 ROME 1940 - Sardinia Island

82 RT 90 - Sweden

83 PROVISIONAL SOUTH AMERICAN 1956 - Bolivia, Chile, Colombia, Ecuador, Guyana, Peru,
Venezuela

84 SOUTH AMERICAN 1969 - Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay,
Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA - Singapore

86 PROVISIONAL SOUTH CHILEAN 1963 - South Chile

87 SANTO (DOS) - Espirito Santo Island

88 SAO BRAZ - Sao Miguel, Santa Maria Islands (Azores)

89 SAPPER HILL 1943 - East Falkland Island

90 SCHWARZECK - Namibia

91 SOUTHEAST BASE - Porto Santo and Madeira Islands

92 SOUTHWEST BASE - Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)

93 TIMBALAI 1948 - Brunei and East Malaysia (Sarawak and Sabah)

94 TOKYO - Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968 - Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916 - Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960 - Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ - Surinam

102 CH-1903 - Switzerland

103 Hu - Tzu - Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan - modified Hu-Tzu-Shan

108 GDA - Geocentric Datum of Australia

109 Dutch
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APPENDIX B: BINARY PHASE OUTPUT FORMAT
Note: The following applies to all software versions of GPS 16LVS, GPS 16HVS, and GPS 17HVS.

Two records are transmitted once per second by the GPS 16/17 series products. One record contains primarily post-
process information, such as position and velocity information. The second record contains receiver measurement
information. The records are sent at a default baud rate of 9600 baud, 8 data bits, and no parity.

Records begin with a delimiter byte (10 hex). The second byte identifies the record type (33 hex for a position
record, 34 hex for a receiver measurement). The third byte indicates the size of the data. The fourth byte is the first
byte of data. The data is then followed by a checksum byte, a delimiter byte (10 hex), and an end-of-transmission
character (03 hex).

Note: If RTCM-104 differential data is sent to the GPS sensor, the board will reset the Phase Output Data baud rate
to the same baud rate used for RTCM-104 data. If the differential inputs are used on the GPS sensor, the RTCM-104
data must be sent to the GPS sensor at 9600 baud (preferred) or 4800 baud. RTCM-104 baud rates less than 4800
baud are not supported by the GPS sensors as it would limit bus bandwidth past the point where a once-per-second
phase output data rate could be maintained.

Position Record
- 0x10 (DLE is first byte)
- 0x33 (Position record identifier)
- 0x40 (Size of data)
- cpo_pvt_data (See description below)
- one-byte checksum (The addition of bytes between the delimiters should equal 0)
- 0x10 (DLE)
- 0x03 (ETX is last byte)

typedef struct
{
float alt;
float epe;
float eph;
float epv;
int fix;
double gps_tow;
double lat;
double lon;
float lon_vel;
float lat_vel;
float alt_vel;
float msl_hght;
int leap_sec;
long grmn_days;
} cpo_pvt_data;
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alt Ellipsoid altitude (meters)
epe Est pos error (meters)
eph Pos err, horizontal (meters)
epv Pos err, vertical (meters)
fix 0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential;

6 and greater = not defined
gps_tow GPS time of week (sec)
lat Latitude (radians)
lon Longitude (radians)
lon_vel Longitude velocity (meters/second)
lat_vel Latitude velocity (meters/second)
alt_vel Altitude velocity (meters/ second)
msl_hght Mean sea level height (meters)
leap_sec UTC leap seconds
grmn_days Garmin days (days since December 31, 1989)

Receiver Measurement Record

- 0x10 (DLE is first byte)
- 0x34 (Receiver record identifier)
- 0xE2 (Size of data)
- cpo_rcv_data (See below)
- one byte checksum (The sum of bytes between the delimiters should equal 0)
- 0x10 (DLE)
- 0x03 (ETX)

typedef struct
{
unsigned long cycles;
double pr;
unsigned int phase;
char slp_dtct;
unsigned char snr_dbhz;
char svid;
char valid;

} cpo_rcv_sv_data;

typedef struct
{
double rcvr_tow;
int rcvr_wn;
cpo_rcv_sv_data sv[ 12 ];

} cpo_rcv_data;

rcvr_tow Receiver time of week (seconds)
rcvr_wn Receiver week number
cycles Number of accumulated cycles
pr Pseudorange (meters)
phase To convert to (0 -359.999) multiply by 360.0 and divide by 2048.0
slp_dtct 0 = no cycle slip detected; non-zero = cycle slip detected
snr_dbhz Signal strength
svid Satellite number (0 to 31) Note: add 1 to offset to current svid numbers
valid 0 = information not valid; non-zero = information valid
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Sample C Code
DLE and ETX bytes:
Sample C code to receive the two records should filter DLE and ETX bytes as described below:
typedef enum
    {
    DAT,
    DLE,
    ETX
    } rx_state_type;

/* Declare and initialize static variables */
static char in_que[ 256 ];
static int in_que_ptr = 0;
static rx_state_type rx_state = DAT;

.

.

.

void add_to_que( char data )
{
#define DLE_BYTE 0x10
#define ETX_BYTE 0x03

if ( rx_state == DAT )
    {
    if ( data == DLE_BYTE )
        {
        rx_state = DLE;
        }
    else
        {
        in_que[ in_que_ptr++ ] = data;
        }
    }
else if ( rx_state == DLE )
    {
    if ( data == ETX_BYTE )
        {
        rx_state = ETX;
        }
    else
        {
        rx_state = DAT;
        in_que[ in_que_ptr++ ] = data;
        }
    }
else if ( rx_state == ETX )
    {
    if ( data == DLE_BYTE ) 
        {
        rx_state = DLE;
        }
    }

if ( in_que_ptr > 255 )
    {
    in_que_ptr = 0;
    }
}
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APPENDIX C: EPHEMERIS DATA DOWNLOAD (PROGRAMMING EXAMPLE)

Synopsis
This section describes, using an example, how to download ephemeris information from a Garmin 15, 16, 17 or 18
family GPS unit with the exception of the GPS 15-W and the GPS 15-F.

Garmin Binary Format Review
To download the ephemeris data, you must first command the unit to output information in Garmin Binary Format
(Garmin mode) instead of the default NMEA output format. To put the unit in Garmin mode, connect to the unit
using a terminal program and send the following NMEA sentence: $PGRMO,,G*hh<CR><LF>  

The checksum *hh is used for parity checking data and generally is not required in normal PC environments, but is
recommended for use in environments containing high electromagnetic noise. When used, the parity bytes (hh) are
the ASCII representation of the exclusive-or (XOR) sum of all the characters between the “$” and “*” characters,
non-inclusive. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that point will
be acted on by the GPS sensor. See Section 4 Software Interface. The unit will stay in Garmin mode until the next
power cycle.

Now that unit is in Garmin binary format, transmitted and received packets are structured as follows:

Byte Description Name Notes
Packet Delimiter DLE 0x10
Packet ID (type) ID Packet type
Data Size SIZE Number of bytes in data portion(not

including escaped DLEs. See below)
Data bytes DATA Not to exceed 256 bytes 
. . .
. . .
. . .
Checksum                CHKSUM 2’s complement of the arithmetic sum of

all the bytes from the Packet ID byte to
the last DATA byte(inclusive) not
counting escaped DLEs. See below

Packet Delimiter DLE 0x10
End of Packet ETX 0x03

The DLE (0x10) is a delimiter byte used in conjunction with the ETX byte to determine beginning and ending of a
packet. However, a 0x10 could appear in the data itself; if this occurs, the byte is escaped with another DLE byte
(sometimes referred to as DLE stuffing). In other words, if a DLE occurs in the data, another DLE is transmitted
immediately after to indicate that it is a data byte and it is not being used as a delimiter. Note that the size byte of the
packet does not count the second DLE byte in an escaped DLE pair in the data field. Since a DLE that is a part of
the data will have a second DLE to escape it, a single DLE followed by an ETX byte means that the end of a packet
has been reached.

In order to interpret these packets properly, one must remove the escaped DLE bytes. This can be achieved using an
algorithm similar to the Sample C Code fragment on the previous page.
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Ephemeris Download Procedure
The following is the sequence of events that occurs when downloading ephemeris. 

Send a packet containing the command that requests ephemeris data (IOP_DOWN_LOAD_EPH). The packet should
look like this:

TX Packet: Ephemeris Data Request

Byte Description Name HEX Value
Delimiter DLE 0x10
Command Data ID IOP_CMND_DATA 0x0A
Number of bytes in data SIZE 0x02
Request to D/L ephemeris IOP_DOWN_LOAD_EPH 0x5D
Pad to 2 bytes DATA 0x00
Checksum calculation CHKSUM 0x97*
Delimiter DLE 0x10
End ETX 0x03
* From now on, checksum calculation will not be shown for every packet example

The unit will return an acknowledgement packet that will look like this:

RX Packet: Acknowledgement

Byte Description Name HEX Value
Delimiter DLE 0x10
Acknowledgement ID IOP_ACK_BYTE 0x06
Number of bytes in data SIZE 0x02
Request to D/L ephemeris IOP_CMND_DATA 0x0A
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

Then, the unit will immediately send a packet communicating how many data packets to expect for the ephemeris
download (a maximum of twelve):

RX Packet: Number of Data Packets to Expect

Byte Description Name HEX Value
Delimiter DLE 0x10
Record ID IOP_RECORDS 0x1B
Number of bytes in data SIZE 0x02
Number of records NUM_SV 0x0C
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

This packet requires acknowledgement, as shown below (note that the data field contains the IOP_RECORDS ID to
indicate the acknowledgement of the IOP_RECORDS packet):

TX Packet: Acknowledgement

Byte Description Name HEX Value
Delimiter DLE 0x10
Record ID IOP_ACK_BYTE 0x06
Number of bytes in data SIZE 0x02
Pad DATA 0x00
ID of packet being ACK’d IOP_RECORDS 0x1B
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03
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Next, the unit will send the specified number of packets containing the ephemeris information. An example packet is
shown below. Each packet should be acknowledged as before (be sure to modify the ACK packet to indicate what
type of packet being acknowledged—for ephemeris data, the ID is 0x35).

RX Packet: Ephemeris Data

Byte Description Name HEX Value
Delimiter DLE 0x10
Ephemeris data ID IOP_SPC_EPH_DATA 0x35
Number of bytes in data SIZE 0x78
Ephemeris data DATA ----
. . .
. . .
. . .
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

The data portion of each packet can then be parsed into an instance of the following structure. Each of these
structures represents data from a single satellite.

typedef struct  /* ephemeris data record for SPC */
{
sint16  wn; /* week number (weeks) */
float   toc;    /* reference time of clock parameters (s) */
float   toe;    /* reference time of ephemeris parameters (s) */
float   af0;    /* clock correction coefficient - group delay   (s) */
float   af1;    /* clock correction coefficient           (s/s) */
float   af2;    /* clock correction coefficient         (s/s/s) */
float   ura;    /* user range accuracy                      (m) */
double  e;      /* eccentricity                             (-) */
double  sqrta;  /* square root of semi-major axis (a)  (m**1/2) */
double  dn;     /* mean motion correction                 (r/s) */
double  m0;     /* mean anomaly at reference time           (r) */
double  w;      /* argument of perigee                      (r) */
double  omg0;   /* right ascension                          (r) */
double  i0;     /* inclination angle at reference time      (r) */
float   odot;   /* rate of right ascension                (r/s) */
float   idot;   /* rate of inclination angle              (r/s) */
float   cus;    /* argument of latitude correction, sine    (r) */
float   cuc;    /* argument of latitude correction, cosine  (r) */
float   cis;    /* inclination correction, sine             (r) */
float   cic;    /* inclination correction, cosine           (r) */
float   crs;    /* radius correction, sine                  (m) */
float   crc;    /* radius correction, cosine                (m) */
unsigned char  iod; /* issue of data */
} SDM_spc_eph_type;
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An example function to do the parsing is shown below. Note that the double data types are converted by the function
cnvt_ieee_double(). This function merely swaps the upper and lower words of the double. This is necessary
on GPS 15, 16, 17 series sensors due to a compatibility issue with the IEEE floating point standard): In this example,
the array m_TempArray contains the data portion of the ephemeris packet (with DLE stuffing removed).
/****************************************************************************
*
*   PROCEDURE NAME:
* copyData - ephemeris data unpacker       
*
*   DESCRIPTION:
* unpacks data from ephemeris packet DATA field after extraneous DLEs
* have been removed.  Note that sint16 refers to a signed 16-bit 
* integer type.
*
****************************************************************************/
void GPM_ephList::copyData /* ephemeris data unpacker */

(
GPM_ephData* pTemp /* pointer to ephemeris data array */
)

{
pTemp->EphStruct.wn  = *(sint16*)&m_TempArray[IDX_EPH_WN];
pTemp->EphStruct.toc = *(float*)&m_TempArray[IDX_EPH_TOC];
pTemp->EphStruct.toe = *(float*)&m_TempArray[IDX_EPH_TOE];
pTemp->EphStruct.af0 = *(float*)&m_TempArray[IDX_EPH_AF0];
pTemp->EphStruct.af1 = *(float*)&m_TempArray[IDX_EPH_AF1];
pTemp->EphStruct.af2 = *(float*)&m_TempArray[IDX_EPH_AF2];
pTemp->EphStruct.ura = *(float*)&m_TempArray[IDX_EPH_URA];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_E]);
pTemp->EphStruct.e = *(double*)&m_TempArray[IDX_EPH_E];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_SQRTA]);
pTemp->EphStruct.sqrta = *(double*)&m_TempArray[IDX_EPH_SQRTA];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_DN]);
pTemp->EphStruct.dn = *(double*)&m_TempArray[IDX_EPH_DN];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_M0]);
pTemp->EphStruct.m0 = *(double*)&m_TempArray[IDX_EPH_M0];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_W]);
pTemp->EphStruct.w = *(double*)&m_TempArray[IDX_EPH_W];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_OMG0]);
pTemp->EphStruct.omg0 = *(double*)&m_TempArray[IDX_EPH_OMG0];

cnvt_ieee_double((long *)&m_TempArray[IDX_EPH_I0]);
pTemp->EphStruct.i0 = *(double*)&m_TempArray[IDX_EPH_I0];

pTemp->EphStruct.odot = *(float*)&m_TempArray[IDX_EPH_ODOT];
pTemp->EphStruct.idot = *(float*)&m_TempArray[IDX_EPH_IDOT];
pTemp->EphStruct.cus = *(float*)&m_TempArray[IDX_EPH_CUS];
pTemp->EphStruct.cuc = *(float*)&m_TempArray[IDX_EPH_CUC];
pTemp->EphStruct.cis = *(float*)&m_TempArray[IDX_EPH_CIS];
pTemp->EphStruct.cic = *(float*)&m_TempArray[IDX_EPH_CIC];
pTemp->EphStruct.crs = *(float*)&m_TempArray[IDX_EPH_CRS];
pTemp->EphStruct.crc = *(float*)&m_TempArray[IDX_EPH_CRC];
pTemp->EphStruct.iod = *(unsigned char*)&m_TempArray[IDX_EPH_IOD];

return;

} /* copyData */
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Each data member of the ephemeris data structure is indexed into the data array of the ephemeris packet and cast as
the appropriate data type.  The indices are as follows (note that they correlate to the data members of the structure
respectively):
#define IDX_EPH_WN 0
#define IDX_EPH_TOC 4
#define IDX_EPH_TOE 8
#define IDX_EPH_AF0 12
#define IDX_EPH_AF1 16
#define IDX_EPH_AF2 20
#define IDX_EPH_URA 24
#define IDX_EPH_E 28
#define IDX_EPH_SQRTA 36
#define IDX_EPH_DN 44
#define IDX_EPH_M0 52
#define IDX_EPH_W 60
#define IDX_EPH_OMG0 68
#define IDX_EPH_I0 76
#define IDX_EPH_ODOT 84
#define IDX_EPH_IDOT 88
#define IDX_EPH_CUS 92
#define IDX_EPH_CUC 96
#define IDX_EPH_CIS 100
#define IDX_EPH_CIC 104
#define IDX_EPH_CRS 108
#define IDX_EPH_CRC 112
#define IDX_EPH_IOD 116

The last packet will be a “download complete” packet that will look like this:

TX Packet: Download Complete

Byte Description Name HEX Value
Delimiter DLE 0x10
Download Complete ID IOP_DL_CMPLT 0x0c
Number of bytes in data SIZE 0x02
Ephemeris Download ID IOP_DOWN_LOAD_EPH 0x5D
Pad DATA 0x00
Checksum calculation CHKSUM ----
Delimiter DLE 0x10
End of packet ETX 0x03

After properly acknowledging this packet (ACK the IOP_DL_CMPLT ID), the ephemeris download is complete.
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APPENDIX D: SENSOR CONFIGURATION SOFTWARE
SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features include the
ability to download GPS sensor configuration, maintain different configurations in files, and perform GPS sensor
configurations quickly with the use of one function key. 

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when using the
software to configure your Garmin sensor. 

Downloading the Sensor Configuration Software
The Garmin Sensor Configuration Software (SNSRCFG.exe) is available
from the Garmin Web site. To download the software, start at
http://www.garmin.com/oem, select the GPS 16/17, and then select
Software Updates. The Garmin Sensor Configuration Software
(SNSRCFG.exe) is included in the software update download. 

Selecting a Model
After opening the program (snsrcfg.exe), the following screen appears.
Select the radio button next to the type of Garmin sensor you are
configuring. 

Connecting to the Sensor
After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the program. 

To configure your sensor, you must first connect to the sensor. 

1. Select Config > Switch to NMEA
Mode (or press the F10 key).

2. Select Comm > Setup to open the
Comm Setup Window.

3. Select the Serial Port to which the
sensor is connected. Select Auto to
have the program automatically
determine the Baud Rate, or select
Manual to manually select the Baud
Rate of the GPS 16/17. Click OK when
done. 

4. Click the Connect icon , or select
Comm > Connect. 

5. To view the current programming of
the sensor, select Config > Get
Configuration from GPS (or press the
F8 key). The current programming of
the sensor is displayed in the window
shown to the right. 

http://www.garmin.com/oem
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File Menu
The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work like most
Windows-based programs. 

Comm Menu
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and disconnect
from the sensor. 

Setup: Opens the Comm Setup Window, shown to the left. Select the Serial
Port to which the sensor is connected from the drop-down list. Then select
Auto (the program determines the baud rate on its own) or Manual (you
then enter the baud rate) for the Baud Rate entry. 

Connect: Select Connect to connect to the sensor to change or view the
configuration. 

Disconnect: Select Disconnect to disconnect from the sensor. 

Config Menu
The Config (Configuration) Menu allows you configure
the sensor as it is connected.

Sensor Configuration (F6): Opens the Sensor
Configuration Window, shown to the right. Many of the
fields in this window should be left alone. Refer to the
beginning of this manual for clarification about some of
these fields. For the most part, this window is used to
enter a new Latitude, Longitude, and Altitude for the
sensor. This is especially helpful when you are
programming the sensor for use in a particular geographic
location. 

Resetting the Unit (Reset Unit) performs a reset on the
unit, much like cycling the power. 

Resetting the non-volatile memory (Reset NonVol) will
clear all of the data from the non-volatile memory. 

NMEA Sentence Selections (F7): Displays the NMEA
Sentence Selections Window. If the sentence is enabled, a
check mark appears in the box to the left of the sentence
name. Click the box to enable or disable to the sentence. 



190-00228-21 GPS 16/17 Technical Specifications Rev. A
Page 33

Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The programming is then
displayed in the Main Interface Window. 

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor. 

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode when
connected to this software. 

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode. 

Update Software (F12): After you have downloaded a new software version for the sensor, you can update the
sensor with the new software. Select Update Software and then select the file using the Open dialog box. You must
locate both the *.rgn file and the updater.exe file. 

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also customize how
the program looks by showing and hiding the Toolbar and Status Bar. 

Help Menu
The Help Menu displays the software version and copyright information. 

 

For the latest free software updates (excluding map data) throughout the life of your
Garmin products, visit the Garmin Web site at www.garmin.com.
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